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Selected Terms Used in this Guide 

 
Default ID — The default ID that appears in new ID fields are placeholders. Changing them 
does not affect the system.  When you change a default ID, the system ensures that the new 
ID is unique.  But, certain characters are not allowed in an ID, including $‘, even though it is 
part of the default ID structure. 
 
Exceptions – Exceptions are used to bypass a particular Protocol State if a set of conditions 
is met. 
 
Expression – An expression is an arithmetic or logical formula automatically calculated by 
the system. The operands of that formula are literal values, such as ‗true‘ or ‗42‘, variables 
created while the protocol is being administered, such as the current subject enrollment level, 
and items within the forms included in Manual Tasks, such as the subject‘s lab results.  
 
Minimum Duration – Minimum Duration is the amount of time that an Action State or a 
Decision State stays idle after activation. This is a set time gap between a trigger and the 
beginning of the action or decision activated by that trigger. This is an optional factor. 
 
Maximum Duration – Maximum Duration is the amount of time allotted for completion of an 
activated Action State or a Decision State. It is the longest time that the designated state can 
run. 
 
Protocol States – Protocol States are points within a protocol where tasks are done, 
decisions are made, and branching and synchronizations occur. There are four types of 
Protocol States: Action, Decision, Branch, and Synchronize. These Protocol States are 
discussed in detail later in this document.  

 
Protocol Event – Events are issued (fired) using a Fire Event Task within an Action State. 
Events are received (heard) using the Trigger Event List within an Action State and a 
Decision State. Events are fired to indicate that a certain operation has been performed or a 
state has been reached, etc. When an Event is fired, all Protocol States including that event 
in their Trigger Event List will start execution. The Protocol State that fires the event idles 
until all states that received the event finish execution. 
 
Tasks — A Task defines an activity that is done in an Action State. An Action State may 
contain a group of Tasks. A Task can be iterated, have exceptions, etc. There are two types 
of Task: automatic and manual. The automatic Task is handled by the system, invisible to the 
end users; the user performs the manual Task (for example, assessment activities). 
Automatic Tasks are: Calculate Task, Data Task, Send Message Task and Fire Event Task. 
 
Variable – A variable is a memory location in the system where data can be stored or 
referenced. In the Clinical Trial system, a variable is identified by its name and its scope. A 
variable name is unique within its scope. The scope of a variable indicates where in the 
system it is stored (Protocol level, Subject level, or State level). Any subject that participates 
in a trial to which a Protocol variable belongs can access that variable. A Subject Level 
variable is duplicated for each subject within a trial; in other words, the data stored in these 
variables will vary depending on the subject. A State Level variable exists only within the 
execution of an Action State 
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TrialSense Collection Station 

 
The TrialSense Collection Station provides a window through which subject data is 
easily entered. Accessed from any modern operating system using a standard Web 
browser, it combines strong security and privacy protection mechanisms with an easy-
to-use interface where clinicians and users enroll and select subjects, enter and review 
case report forms, and recognize possible adverse events. 
 
When working with a subject, the user is shown the specific set of tasks to be performed 
at a particular visit, as mandated by the trial protocol.  This automated task sequencing 
enables stricter protocol compliance and minimizes deviations.  As clinicians enter 
collected data and indicate the completion of each task, TrialSense immediately 
computes the next tasks to be performed with the same subject and advises the user 
accordingly. 
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Logging into the System 

When the TrialSense website is first accessed, it will require a user to login.  The user 
must enter a valid username and password to gain access the system. 
 

 
The TrialSense Login Screen 

 
 

 

The username and password are assigned and changed within the TrialSense 
Console. 

 

 

Once the username and password are entered, the user can either click on the 
Login button or hit the Enter key. 

 

 

Hitting the Reset button will clear the username and password entry fields. 

 
If the username or password is incorrect, an error message will be displayed.  The user 
can attempt to log in again. 
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Selecting a Site 

Once the user has logged in they must select the site from which they are currently 
operating.  After the site has been selected, the user can press the Select button or hit 
the Enter key to advance.  If the user is only a member of one site then this screen will 
not be shown, and the site will automatically be selected for the user. 
 

 
The Site Selection Screen 
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Selecting a Trial 

Once a site has been established for the user, the Collection Station proceeds to the 
trial selection screen.  This screen will show all of the active trials available to the user.  
For each trial listed on this screen, a display of the trial id, protocol id and version, 
extended trial name, and brief trial description will be shown.  In order to proceed with 
the selection of a trial, the user must click on the corresponding trial id link from the list. 
 

 
The Trial Selection Screen 

 
The trial description area provides a link to view a more expansive description of the 
trial which will open in a new browser window.  
 

 
A Description Popup for the Trial 
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Selecting a Subject 

Once the user has selected a trial, a new page will be displayed that shows a brief 
overview of the trial selected along with a list of subjects.  Any of the subjects listed may 
be accessed by the user to continue the trial.  The user also has the option to create a 
new subject as long as they have the proper permissions.  If the user cannot create a 
new subject, an error message will be displayed to indicate this.  The subject list will be 
populated using some type of identifier for the subjects.  The subject identifier is 
commonly represented by the subject‘s name, the subject‘s initials, or a unique subject 
identification number.  Once the user has selected a subject to work with, they can 
proceed by pressing the Select Subject button. 
 

 
The Subject Selection Screen 

 

 

If the user creates a new subject, they will automatically proceed to the first 
state of the trial. 
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Administering the Trial 

Once a subject has been selected, a page will be displayed that shows information 
corresponding the subject‘s status within the trial.  The current trial information and 
subject identifier are printed on a header toward the top of the screen.  Below the 
header is a navigation panel that is divided into three sections.  The top portion of the 
screen gives an overview of both the trial and the subject that were selected by the 
user.  The lower portion is divided between the state and decision selection list on the 
left and the selected state or decision panel on the right. 
 

 
The State Screen of the TrialSense Collection Station 

 

 

 

Should the user not interact with the TrialSense Collection Station for an 
extended period of time, an inactivity timeout will occur and the session will be 
closed resulting in the user being logged out of the system. 
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Working with States and Decisions 

On the left side of the Collection Station screen is list of all current and completed states 
for the subject.  The completed states have no additional tasks to perform or decisions 
to make, whereas the current states still have tasks that are active or have yet to begin 
or have manual decisions that must be made. 
 

 
The Current and Completed State and Decision List 
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Working with the State or Decision Panel 

After clicking on a state from the list, the right side of the page will show the tasks or 
decision options related to the state.  For each task the name and an optional 
description is listed on the screen along with the status of the task.  The task status can 
be indicated as either Not Started, Started, Completed, Skipped, or Failed.   For most 
tasks, a form accompanies the task that must be filled out.  The form can be viewed by 
selecting the Open button under the Actions portion of the task.  Filling out and 
completing forms is explained in more detail in the section ―Working with Forms‖ in the 
guide.  Once a form has been started it can be edited and saved until the user is 
satisfied with the data.  At this point the user can select to complete the form which will 
set the task to a status of Completed.  For a user to complete a form, they must select 
the Mark Complete option from the File menu of the form.  Choosing this option will 
force the user to sign the form indicating an assurance that the data within the form has 
been reviewed and is accurate.  The user also has the option to sign form data at any 
point when filling out the form prior to completion.  Task data that has been signed is 

indicated by a signed icon  displayed next to the task name. 
 

 
The Task and Subroutine List for a Selected State 

 
For data that has been completed, a user is able to review the data by selecting the 
Review button under the Actions list.  The form will open in a read-only format allowing 
the user to view the completed set of data for the subject and task.  The user also has 
the option to skip tasks that are not considered mandatory within the trial.  For each 
state that contains tasks to be performed, the task may be displayed in one of two 
methods.  If the tasks must be performed in a specific sequential order, then only one 
active task is shown at a time.  Subsequent tasks are not displayed until the prior task 
has been marked as complete.  For states in which the task can be performed in any 
order, all of the tasks are displayed on the screen at once, allowing the user to complete 
the tasks in the order they prefer.  A state can not be completed until all of the 
mandatory tasks have been completed.  Once a state is completed, the trial will 
advance the user to the next available state for the subject.  Any given state may also 
contain a set of subroutines that must be completed as well.  These subroutine states 
and associated tasks are displayed underneath the main set of tasks and are indicated 
by a dashed line surrounding the entire subroutine state. 
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If a decision point has been chosen from the list, the decision selection panel on the 
right side of the screen will present users with multiple options from which to select.  
The user must choose one of the options before proceeding to the next state of the trial. 
 

 
An Available Decision Point 

 
A Completed Decision Point 

 
 

 

It is also noted that additional information regarding a state can be viewed by 

clicking on the information icon  next to the name of the state.  
 

 
An Informational Popup for the State 

 

 

For states that have already been completed, the user has the ability to view the 
collected data be selecting the state name under the list of completed states on 
the left side of the page.  Each task in the state that has associated data can be 
reviewed in a read-only mode. 
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Viewing the Trial Status 

Once a subject has been selected and the user has proceeded to the main trial screen 
that lists the current and completed states and tasks, they will be provided with an 
opportunity to view the current status of the subject in relation to the complete trial.  A 
link located underneath the main heading with the text ―Visually track the selected 
subject's progress in trial‖ can be clicked by the user to view a graphical representation 
of the subject‘s standing within the trial. 
 
 

 
A Link to the Subject’s Graphical Trial view 
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Graphical Trial View 

When this link is selected, a new browser window will open up displaying a view of the 
entire trial.  The path that the subject has traveled is highlighted by green arrows 
connecting the states that have been traversed and decisions that have been selected.  
A green check mark next to the object indicates a completion of the state or decision, 

whereas an hourglass  indicates that the state is currently in progress or the decision 
has yet to be made. 
 

 
A Full View of the Trial 

 
States that have shadows beneath them indicate the existence of a subroutine.  By 
double-clicking on any of these states, a new window will appear with a list of the 
subroutines for the state.  The states within the subroutine that have been completed 
will have an appearance identical to those in the previous screen.  
 

 
The Subroutine Selection Screen 
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Working with Forms 
Once a task has been opened by the user from the Actions column, the Form Data 
Capture interface appears on screen, showing a form as its layout specifies, and if 
applicable, showing the existing data for the form. A form contains explanatory text for 
the user or clinician, and answer collection controls, which provide for user interaction to 
capture data. 

Entering Data 

There are five main types of answer collection controls: 
 

o Radio buttons are round buttons that (typically) allow only one selection out of 
a set of possibilities. The selected radio button is shown with a black dot within 
a circle, while unselected radio buttons are shown as open circles. To select a 
radio button, simply click on it with the mouse or tap it with the stylus. When 
using the keyboard, navigate with the up and down arrow keys to the desired 
selection and either tap the space bar or hit the enter key to select. 

 

 
A Set of Radio Buttons 

  
 

o Checkboxes allow multiple selections from a set of possibilities. Selected 
checkboxes are shown with a check mark inside a square box; unselected ones 
are empty boxes. Similar to a radio button, to select a checkbox, simply click on 
it with the mouse or tap it with the stylus. When using the keyboard, navigate 
with the up and down arrow keys to the desired selection and either tap the 
space bar or hit the enter key to select. 

 

 
A Set of Checkboxes 
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o Text boxes are boxes where text can be entered and/or displayed. To enter 
data into a text box, either type it with the keyboard or use the Tablet Input 
Panel and/or virtual keyboard to enter data. Input-type text boxes allow a single 
line of data, while text areas are a special type of text box that allows multiple 
lines of data, presenting if necessary a scroll bar to allow text to continue to 
grow. 
 

 
Different Types of Text Boxes 

 
o Drop down lists (sometimes called combo boxes) look like a text box with an 

arrow to the right side. When located on this control, clicking on or tapping the 
arrow displays a list from which a single selection can be made. Using the 
keyboard, hitting the Enter key displays the list; the up and down arrows permit 
the selection of one of the items in the list, which is then selected using either 
the space bar or the Enter key. 

 

 
A Drop Down List 
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o Drawing panels allow the user to sketch a picture based on the question in the 
form, or to leave a handwritten note.  In either case, the drawing is done directly 
on the screen with the mouse or stylus at certain areas of the form.  All 
drawings are viewed as images, which can then be saved and will be 
redisplayed and editable when the form is subsequently opened. 

 

 
Drawing Intersecting Pentagons 

 

Information Popups 

Popups provide the user with additional information relative to an item.  The user can 
click a corresponding button and the information, question, or other data space will be 
displayed in a window separate from the main form. 
 

 
An Informational Popup to Use with Drawing Areas 
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Tool Tips 

Tool Tips provide additional information to the user specific to an answer collection 
control.  When the mouse hovers over an answer, the tool tip will pop up. 
 

 

 
A Tool Tip is Displayed for the Answer Option ‘Yes’ 
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Navigating within the Form 

In order to enter the collected information into the form, the user must be able to 
navigate from one control to another. Navigation also needs to occur to and from the 
buttons that represent the popups. To perform this navigation, three different 
mechanisms are available: keyboard navigation, navigation buttons, and a navigation 
tree. 
 

Keyboard Navigation 

To go from one control or popup button to another, the Tab and Shift-Tab keys are 
used. Tab proceeds forward in the direction of the form (usually, left-to-right, top-to-
bottom), while Shift-Tab proceeds in the reverse direction. The active control or popup 
can be easily distinguished by a conspicuous dotted border or by an editing cursor. 
 
The Page Up and Page Down keys permit more accelerated navigation, by displacing 
the active control marker roughly one screen down or up, respectively. 
 

Navigation Buttons 

The Previous and Next navigation buttons provide the user with the same functionality 
as the Shift-Tab and Tab keys, respectively, and are better suited for use with a mouse 
or stylus. The navigation buttons are located on the tool bar of the form, and also on the 
Edit menu. 
 

 
Previous and Next Navigation Buttons 
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Navigation Tree 

The Navigation Tree shows the complete form layout within a tree view.  The user can 
switch to the Navigation view of the form by selecting the "Tree" button on the toolbar, 
or by using the ―Show Navigation Tree‖ menu item on the ―View‖ menu. Item groups 
within the tree can be expanded to view the items and subgroups within the group.  By 
selecting and item or group, the focus of the form will jump to the selected area.  The 
Navigation Tree can also be hidden by again choosing "Tree" from the toolbar or by 
using the ―Hide Navigation Tree‖ menu item on the ―View‖ menu. 
 

 
Navigation Tree View 

 

 

Read-only Data 

In some cases, users will have permission to read and review a piece of data, but not 
be able to modify the data.  When viewing read-only data, the user can only traverse 
between items in the form by using the navigation tree or the scrollbar. 
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Running Headers 

A running header is an information bar that updates the user as to their current 
position within the form.   As a user traverses the form, the running header will display 
the name of the form section where the cursor is focused.  The running header 
provides a quick reference for the user as to the section of the form for which the item 
they are working with is located.  The running header is situated between the toolbar 
and the form. 

 

 
Running Header 

 

Highlighted Items 

Highlighted items alert the user as to the current focus of the cursor within a form.  
These items appear with a background color that is different to the color of the other 
items within the form. The highlighted item should be the item with which the user is 
presently working. 

 

 
Highlighted Item in Light Yellow 
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Multi-Valued Tables 

Entering data on Multi-Valued Tables 

Tables can be constructed to collect multiple sets of data with the same general 
structure.  When a table is empty, a single row of empty data is shown on screen; when 
new data is entered into any field within this empty row, the table automatically 
expands, always showing an empty row at the end of the table. 
 

 

Not all tables are multi-valued. Some tables are simply a group of answer 
control mechanisms aligned in a tabular manner. These non-multi-valued tables 
do not grow, and do not have delete buttons. 

 

 
The Multi-Valued Table Always Shows an Empty Row 

 

 
The Multi-Valued Table Adds New Rows Automatically 

 

 

Navigating within a Multi-Valued Table 

Each cell within a table contains an answer collection control. To navigate among these, 
the usual navigation methods (keyboard, buttons) are used. When navigation reaches 
the last cell of the empty last row of the table, selection proceeds to the next item within 
the form. 
 
 

 
Unlike other interfaces, using the Tab key at the last cell on the last row does 
not insert a new empty row. Insertion of an empty row is achieved by entering 
data in any field within the last row of the table. 
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Deleting Table Rows 

All table rows have a delete button at the right side of the row; all but the last button are 
enabled. Clicking on this delete button displays a confirmation message; accepting the 
message by selecting OK removes the entire row from the table. 
 
 

 
Removing a Row from a Multi-Valued Table 
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Inserting and Removing Annotations 

An annotation allows the user to enter additional information relative to the item.  
Included can be comments, descriptions, or other data the user may desire to provide. 
Annotations are inserted by clicking on the Add Note button on the toolbar, or by 
selecting the Add Note menu item on the Edit menu; insertion of an annotation is done 
at the item whose answer collection control is selected.  
 
Annotations can only be inserted if the design of the form allows it; otherwise, the Add 
Note toolbar and menu item are disabled. Multiple annotations can be inserted at the 
same item; each annotation is displayed with a user ID and a creation date. 
 
To remove an inserted annotation, the annotation itself must be currently selected (by 
having the text cursor, i.e., an I-shaped cursor, showing on the annotation body). When 
the Remove Note toolbar button, or the Remove Note menu item in the Edit menu, is 
selected, a dialog requesting confirmation appears; if the user confirms, the note is 
deleted from the form. 
 

 
Adding an Annotation to the Item 

Undo/Redo 

The Data Capture system allows the user to cycle backwards or forwards though the 
changes made to a form by using the Undo and Redo buttons, or the ―Undo‖ and 
―Redo‖ menu items in the ―Edit‖ menu.  By selecting Undo, the most recently changed 
data will revert to its pre-changed value.  The user may continue to select the Undo 
button and the old data will be restored, one change at a time.  If the user decides to 
reestablish the changes made to the data, the Redo button can replace the data 
change made by using the most recent Undo action.  Continuing to select the Redo 
button allows the user to cycle forward though each of the Undo actions selected, 
progressively replacing the data. 

Most actions are undoable, including the entry or selection of data, and the insertion or 
removal of annotations and table rows. 



          TrialSense Collection Station User’s Guide 

  26 

In most answer collection controls, including single line input text boxes, the undo and 
redo actions switch between values set after the control loses its selection. In text 
areas, however, undo and redo work at the character insertion level. 

 

 

Undo and Redo have an accelerator key, that is, a key stroke that has the same 
functionality as the toolbar button. For Undo it is Ctrl-Z and for Redo it is Ctrl-Y. 
 

 

 
The Undo and Redo Buttons 

 

Automatic Calculations 

An output expression is an automatically calculated result, based on data within the 
form or from other forms within the system.  Output expression examples are a total 
score based on the sum of a users answers, a calculation of an age or range of years 
based on provided dates, or a determination of truth or falsehood for a determined 
condition. These output expressions are usually displayed within the form on output 
boxes, which are similar to input text boxes, except that they do not allow entry of data, 
and are shown in a different, system-specific coloring (gray on Windows systems). 
 
A calculated field is updated automatically whenever data that affects its result is 
changed. 
 

 
Output Expression Calculates the Sum of Selected Values 
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Conditional Processing 

The Task-based Data Capture has a comprehensive system for processing of 
conditions within the form. These conditions are generally dependent on the data within 
the form itself, and could also depend on data within other forms. They can be triggered 
by one or more of the following events: 

o Upon form opening 
o Upon selection (focus) reaching an answer collection control 
o Upon selection (focus) leaving an answer collection control 
o Upon a change in value in the answer collection control. 

 

 

The event that triggers processing of a condition, as well as the nature of the 
condition itself, are determined by the design of the form. 
 

 
There are three types of conditional processing results: alerts, enabling / disabling of 
items, and logic flow. 

 

Alerts 

An alert is an informative message displayed to the user, triggered by a condition. Alerts 
are used to warn the user or clinician about potentially ambiguous or contradictory 
responses, or in general to provide help and guidance. 
 

 
Customized Alert Message 
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Item Enabling/Disabling 

Individual questions or entire sections within a form may be automatically enabled for 
answering or disabled to prevent answering by the user.  Among reasons of disabling 
questions are if the questions are gender specific, if they are age or time related, or are 
otherwise determined to be disregarded or unnecessary based on the user's answers to 
other questions.  Enabling questions may occur if the age or gender is applicable, if the 
questions are determined to be relevant based on previous answers, or if answer(s) 
causing a question to become disabled have been changed, therefore re-enabling the 
question. 
 

 
Disabling the Textbox 

 

Logic Flow 

Logic flow is used to guide the user through the form based on the form's logic 
structure.  As the user answers questions, any associated logic conditions are 
calculated.  As conditions are met, a message is displayed notifying the user of the 
condition and the next question or section to complete.  If the user accepts, the form will 
automatically jump to the next question for the user to answer. 
 

 
Logic Flow Alert Displayed Based on Selected Answers 
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Reports 

The data capture interface allows the user to print out a report for a set of form data.  
The user must have a chosen task data set open to view the corresponding report.  The 
user can select to view a preview of the report by choosing the Print Preview option 
under the File menu.  Selecting Print will print the report. 
 

 
Report View for a Set of Form Data 

 
Additionally, the user may choose to save a PDF version of the form.  By selecting the 
Save as PDF option from the File menu, the user will be prompted to choose a directory 
to which the PDF version of the task data will be saved. 
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Saving Form Data 

Once the user has completed editing the form, the data may be saved as modified data 
or as new data.  To save as modified data, the user selects Save Data from the menu 
bar or toolbar. This will override the old data with the updated data, but retain the same 
form date used in the selection list. 
 
After a form is saved, the Save Data button and menu item are disabled. They become 
re-enabled when any data is modified within the form. 
 

 
Saving Form Data 

 
 
The user also has the option to enable an automatic saving feature.  Selecting the 
Autosave Settings… option from the File menu will display a popup from which the user 
may turn the autosave feature on or off.  Additionally, the user can set the number of 
minutes between automatic savings of the task data. 
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Signing Form Data 
Each set of form data can be signed by a user with an appropriate permission level.  By 
signing the form data, the user validates the authenticity of the collected information.  In 
order to sign the data, the user selects the Sign Data option from the File menu on the 
form. If the data currently on screen has not been saved yet, the user is prompted to 
confirm saving the data before signing. If the user does not elect to save, then the data 
is not signed. 
 

 
Prompt to Save Data before Signing 

 
If the data on screen was already saved, or if the user selects to save before signing, 
then the system requests the user to reconfirm her or his password, to ensure maximum 
security for the signature.  
 

 
Request for Password to Sign Data 
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If the password is incorrect, the user is informed and the form is not signed; otherwise, 
the form is signed and the user may continue editing it or may exit the form data 
capture. 
 

 
Password Entry Failed 

 

Often, users may wish to sign an instance of data to validate its authenticity and 
accuracy.  Once form data has been signed, an icon appears next to the data on the 
state page next to the task name. 

 

 
Signed Data with Icon 
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Once signed data has been opened, an entry list is displayed at the bottom of the form 
to indicate when the data was signed, and by which user. 

 

 
Signature List with Users and Dates 

 

The signatures can be shown or hidden by selecting the Show Signatures option from 
the View menu. 

 

 
Show Signatures Menu Option 

Completing Form Data 

Once the data collection for a form has been completed by the user, the form must be 
marked as complete in order to finish the task.  Selecting the Mark Complete option 
from the File menu will force the user to enter a password in order to confirm the 
completion process and ensure the accuracy of the data.  The data in the form will be 
signed and the task will be closed. 
 

 
Mark Complete Menu Option 
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Closing Form Data 

To close a form data, the user selects the Close menu item in the File menu, or the 
close button on the top right corner of the window. If the current data has not been 
saved, the system asks the user if he or she wants to save the form, return to the form, 
or close without saving. By default, the ―Save and Close‖ option is selected; the user 
can click or tap on any of the other buttons, or navigate among them using the Tab key. 
 

 
Request to save data before closing a form 

 
 
 
 
If ―Save and Close‖ is selected, the data is saved and the form is closed. If ―Return to 
form‖ is selected, then no data is saved but the form continues to show on screen. If 
―Close without saving‖ is selected, the form presents an additional confirmation dialog, 
warning the user that data may be lost. 
 

 
Confirmation dialog to close a form without saving 

 
If the user selects the ―Yes‖ option, data is not saved and the form is closed. If the ―No‖ 
option is selected, the form is not closed, and data is not saved. 


